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1. Introduction

SocScape (Social Landscape)
is a research project which provides open
access to high resolution (30 m) population,
subpopulation (separate race/ethnicity group)
and racial diversity grids for the entire
conterminous United States for 1990, 2000,
2010.

High resolution grids are available for download using SocScape - GeoWeb
application (http://sil.uc.edu/webapps/socscape_usa/) or SocScape data website
(http://sil.uc.edu/cms/index.php?id=socscape-data)
SocScape - GeoWeb application provides an access to population and racial
diversity grids for the entire U.S and it allows to download data for selected region
(up to 100 000 km2).

SocScape data website provides population, subpopulation and racial diversity
grids for each county and for 363 metropolitan area (MSA) as a zip archive
containing data for 1990, 2000, 2010. In addition, for urban areas within 351 MSA
are available racial diversity change maps for 1990-2000, 2000-2010, 1990-2010
comparison.

Data are saved as GeoTiff and shapefiles (change map) and can be opened in GIS
software.

QGIS is a free, user friendly Open Source

Geographic Information System (GIS) software
http://qgis.org/en.
QGIS is available on Windows, MacOS X, Linux and
can be downloaded from
http://qgis.org/en/site/forusers/download.html
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2. SocScape data

SocScape data is a website, which provides data for each county and
363 metropolitan areas as a zip archive. This website is available at

http://sil.uc.edu/cms/index.php?id=socscape-data

This website made available high resolution demographic grids for each county in
the conterminous U.S. and for 363 MSA for 1990, 2000 and 2010. Data are
organized as a zip archive.
Each archive contains 3 directories:

• population - contains population grids for each year (4 grids)
• diversity - contains racial diversity classification grids for each year (4

grids)
• race - contains separate grids for 7 race/ethnicity groups for each year

(27 grids)
All data are provided in Albers Conical Equal Area projection (EPSG: 5070).

Additionally for urban areas within metropolitan areas we made available racial
diversity change map, which shows temporal changes in racial diversity as a single
map. This map is available as shapefile for 1990-2000, 2000-2010 and 1990-2010
comparison.

Fig. 1. Download SocScape data by county and MSA
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3. Download SocScape data for selected county

Download high resolution grids for Cook  County, IL. 

From the dropdown menus select the Illinois as a state name (left menu) and next
Cook County as a county name (right menu). Selected county will be shown below
the dropdown menu. Click on "Download" button to download a zip archive.

Fig.2. Download SocScape data  for Cook county, IL.

Name of each zip archive contains 2-letters state code and county name. In this
example file will be named il_cook.zip, which indicates Cook county in the state of
Illinois.

Unzip a zip archive. Zip archive contains 3 directories: population, race, diversity.

Visit http://sil.uc.edu/cms/index.php?id=high-resolution-demographic-grids-data-
description for more detailed information about data.
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4. Getting started with QGIS

QGIS is available on Windows, MacOS X, Linux and can be downloaded from
http://qgis.org/en/site/forusers/download.html
To install QGIS download version for your operating system and follow the wizard

installation instruction.
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QGIS has a lot of documentation which is available at http://docs.qgis.org
Please visit http://docs.qgis.org/2.18/en/docs/user_manual/index.html
for detailed user manual.

QGIS GUI is described here:
http://docs.qgis.org/2.18/en/docs/user_manual/introduction/qgis_gui.html
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This short guide assumes using QGIS v2.18 for Windows.

Fig.3. QGIS main window

http://qgis.org/en/site/forusers/download.html
http://docs.qgis.org/
http://docs.qgis.org/2.18/en/docs/user_manual/index.html
http://docs.qgis.org/2.18/en/docs/user_manual/introduction/qgis_gui.html
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4. Getting started with QGIS

Load raster or vector data into QGIS

Load raster data to QGIS 
• from main menu choose Layer – Add Layer - Add Raster Layer or clik on the 

icon in the left panel of QGIS window. 

• Browse to the folder with data, select name of raster layer and open it. 

Load vector data to QGIS 
• from main menu choose Layer – Add Layer - Add Vector Layer or choose the 

icon in the left panel of QGIS window. 

• Browse to the folder with data and select name of vector layer with shp 
extension and open it. 

Fig.4. Add raster layer dialog

Fig.5. Add vector layer dialog and open vector layer



4. Getting started with QGIS

Symbolizing Layer using color map form text file
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More information: 
http://docs.qgis.org/2.14/en/docs/user_manual/working_with_raster/

To view and set the properties for a
raster layer, double click on the layer
name in the map legend, or right click
on the layer name and choose
Properties from the context menu. This
will open the Raster Layer Properties
dialog

Render type

Load min/max value

Fig.6. Properties from context menu

Fig.7. Layer properties dialog



Go to Style menu in Raster Layer Properties dialog.
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Load min/max value
Click on     to show min/max value option. 
Choose (A) Min /Max, (B) Accuracy – Actual (slower) 
and click on Load button (C)  

A
B
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3
4 Load color map from file using icon in the Layer Properties for a singleband

pseudocolor window and choose an appropriate color map text file. 

Select „Discrete” as interpolation method.  

4. Getting started with QGIS
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Fig.8. Raster layer properties dialog

Fig.9. Load min/max value in Raster layer properties 



4. Getting started with QGIS

Calculations on the basis of existing raster can be perfomed using Raster Calculator
in the Raster menu. The results of calculation are written to a new raster layer.
Raster calculator allows to calculate population density based on population grids
or percentage maps based on race and population grids.

Space Informatics Lab – University of Cincinnati

• Raster bands - contains all loaded raster layers that can be used for
calculations.

• Raster calculator expression field – contains formula used in calculations. To
add a raster to the raster calculator expression field, double click its name in the
Raster band fields list. You can then use the operators to construct calculation
expressions, or you can just type them into the box.

• Result layer section define an output layer: name of the output layer, output
format, output CRS and the extent of the calculation area (based on an input
raster layer, or based on X,Y coordinates and on columns and rows, to set the
resolution of the output layer).
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Calculating new maps in QGIS

Fig.10. Raster calculator window



5. Working with racial diversity grids in QGIS

Open racial diversity map in QGIS
Open QGIS Desktop 
Load raster data to QGIS 

• from main menu choose Layer – Add Layer – Add Raster Layer or choose the 
icon in the left panel of QGIS window. 

• select il_cook_div2010myc.tif from il_cook/diversity directory and open it. 

Racial diversity map is displayed in QGIS already with the right color map. 
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Fig.11.  Racial diversity of Cook county, IL area in 2010 loaded to QGIS



5. Working with racial diversity grids in QGIS
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Save map as image 

Map displayed in Map window in QGIS can be saved as image (PNG, JPG) using 
Projects – Save as image from main menu. 

Fig.12.  Racial diversity of Cook county, IL area in 2010



6. Working with population grids in QGIS
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Open population data in QGIS
Open QGIS Desktop 
Load raster data to QGIS 

• from main menu choose Layer – Add Layer – Add Raster Layer or choose the 
icon in the left panel of QGIS window. 

• select il_cook_pop2010myc.tif from il_cook/population directory and open it. 

Population map is displayed in grey colors. A color map for population map is provided
in a text file (population_color.txt)

Fig.13.  Population distribution of Cook county, IL area in 2010 loaded to QGIS



Following an instruction ”Symbolizing Layer using color map from text file” from 
the section Getting started with QGIS set color to 
il_cook_pop2010myc map:

• Right click on the il_cook_pop2010myc name in Layer Panel
• Choose Properties from the context menu.
• Go to Style menu in Raster Layer Properties dialog.
• As a render type choose Singleband pseudocolor
• In Load min/max values options set Min /Max, Accuracy – Actual (slower) and

click on Load button
• Select ”Discrete” as interpolation method.
• Load color map from file using icon in the Layer Properties for a singleband

pseudocolor dialog window. 
Color file is saved as population_color.txt

• Click on OK in Raster Layer Properties dialog. 
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6. Working with population grids in QGIS

Symbolizing Layer using user define color map

Fig.14. Raster layer properties dialog for population distribution
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6. Working with population grids in QGIS

Symbolizing Layer using user define color map

Fig.15.  Population distribution of Cook county, IL area in 2010 loaded to QGIS
(with user define color)



6. Working with population grids in QGIS
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Save map as image 

Map displayed in Map window in QGIS can be saved as image (PNG, JPG) using 
Projects – Save as image from main menu. 

Fig.16. Population distribution of Cook county, IL area in 2010 



7. Calculate population density

• Choose output directory                     and type output name: 
il_cook_pop2010myc_km2.tif

• Check                                    (the result of calculation will be add to QGIS) 

• Clik OK.

The resultant map will be saved in selected directory and add to Layer Panel in QGIS.
Population density map is shown in grey colors.
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Calculate population density per km2 for Cook 
county, IL 

• Select Raster Calculator in the Raster menu.
• Construct calculation expressions:

il_cook_pop2010myc@1/0.0009

Double click fields list to  add raster to Raster calculation expression field. 
on the name of raster (il_cook_pop2010myc@1) in the Raster band

Fig.17. Raster calculator expression
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Symbolizing Layer using user define color map

7. Calculate population density

Following an instruction ”Symbolizing Layer using color map from text file” from 
the section Getting started with QGIS set color to set color to 
il_cook_pop2010myc_km2.tif map. Colors are saved in population_km2_color.txt

Fig.18. Raster layer properties dialog for population density 

Fig.19. Population density of Cook county, IL area in 2010 loaded to QGIS
(with user define color)
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8. Calculate racial percentage maps

Load population grid to QGIS 
• from main menu choose Layer – Add Layer - Add Raster Layer or choose the 

icon in the left panel of QGIS window. 

• select il_cook_pop2010myc.tif from il_cook/population directory and open it. 

Load race grid to QGIS 
• from main menu choose Layer – Add Layer – Add Raster Layer or choose the 

icon in the left panel of QGIS window. 

• select il_cook_hispanic2010myc.tif from il_cook/race directory and open it. 

Calculate percentage of Hispanic 
Percentage is calculated using Raster calculator from Raster menu. The general 
expression will be: 

(race grid/population grid)*100

where race is a race/ethnicity grids and population grids is a total population grids. 

• Select Raster Calculator in the Raster menu.
• Construct calculation expressions:

("il_cook_hispanic2010myc@1" / "il_cook_pop2010myc@1")*100

Double click fields list to add raster to Raster calculation expression field. 
on the name of raster (il_cook_hispanic2010@1, il_cook_pop2010myc@1)

in the Raster band

• Save new map as il_cook_perc_hispanic2010myc.tif

Calculate percentage map for Hispanic in 2010 
for Cook county, IL 
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8. Calculate racial percentage maps

Raster calculator allows to percentage maps based on race and population grids.

Fig.20. Calculating percentage maps using Raster Calculator
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8. Calculate racial percentage maps

Symbolizing Layer using user define color map

Fig.21. Raster layer properties dialog for percentage map

Fig.22. Percentage of Hispanic in Cook county, IL in 2010 (with user defined colors)

Following an instruction 
”Symbolizing Layer using color 
map from text file” from the 
section Getting started with QGIS 
set color to 
il_cook_perc_hispanic2010myc.tif 
map. Colors are saved in 
percentage_color.txt



8. Calculate racial percentage maps
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Save map as image 

Map displayed in Map window in QGIS can be saved as image (PNG, JPG) using 
Projects – Save as image from main menu. 

Fig.23. Percentage of Hispanic in Cook county, IL in 2010
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9. Working with change maps in QGIS

SocScape data website (http://sil.uc.edu/cms/index.php?id=socscape-data) made
available racial diversity change maps. Change map is available as shapefile format
for 351 metropolitan areas and is limited to 2010-urban areas of main city in MSA.

Racial diversity change map (or change map) show temporal change in racial
diversity in a single map. Change map is created in the basis of a high resolution
(30m) two-dimensional classification of grid cells into 14 categories based on racial
diversity level and dominant race. We use racial diversity map for 1990, 2000, 2010
years. This map is available as shapefile for 1990-2000, 2000-2010 and 1990-2010
comparison.
Change map show unchagned areas in original colors assigned to each of 14
diversity/dominant race classes. Changed areas are shown in stripes with the color
of narrower stripes indicating the classes in first time point (i.e 1990 for 1990-2000
comparison) and broader stripes indicating the class in second point time (i.e 2000
for 1990-2000 comparison).

Racial diversity change maps are downloaded as a zip archive for selected
metropolitan area. Each zip archive contain DataDescription.pdf file with detailed
description of data.
Each archive contains 5 directories:
• chicago_il_change_map_1990_2000 – contains shapefile with racial diversity

change map for 1990-2000 and *.qml legend file – legend file for QGIS.
• chicago_il_change_map_2000_2010 – contains shapefile with racial diversity

change map for 2000-2010 and *.qml legend file – legend file for QGIS.
• chicago_il_change_map_1990_2010 – contains shapefile with racial diversity

change map for 1990-2010 and *.qml legend file – legend file for QGIS.
• Legend files – contains 8 files: *.lyr file is a symbology to use with ArcGIS and

*.sld is a file to use with older version of QGIS
• Transition matrix – contains transition matrix csv files. See DataDescription.pdf

for more information.

Each shapefile 2 attribute columns: value – is a number of category (1-196), label –
is a description of change, i.e. WL-WM means, that white low diversity area change
into white medium diversity.
All data are provided in Albers Conical Equal Area projection (EPSG: 5070).

http://sil.uc.edu/cms/index.php?id=socscape-data
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9. Working with change maps in QGIS

Download change map for selected 
metropolitan area. 

• Go into SocScape data website (http://sil.uc.edu/cms/index.php?id=socscape-
data)

• From the left dropdown menu select the last position on the list - metropolitan
areas (change) and next from the right menu select name of MSA.
Selected metropolitan area will be shown below the dropdown menu. Click on
"Download" button to download a zip archive. Here is presented an example
for Chicago, IL metropolitan area

Fig. 24. Download change map  for Chicago metropolitan area

Name of each zip archive contains the prefix “msa_change”, the name of
metropolitan area and 2-letters state code. In this example there will be
downoladed zip archive named msa_change_chicago_il.zip
Each archive contains data for analysis of racial diversity change and description
file with detailed information about dataset.

http://sil.uc.edu/cms/index.php?id=socscape-data
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9. Working with change maps in QGIS

Open change map in QGIS
Change map is available as vector in shapefile format. 
Load vector data to QGIS 

• from main menu choose Layer – Add vector Add Vector Layer or choose the 
icon in the left panel of QGIS window. 

• select chicago_il_change_map_1990_2000 from the direcotry with the same 
name as vector file and open it. 

Change map will be displayed with correct color legend. 
(chicago_il_change_map_1990_2000 directory contains shapefile data and *.qml file 
with color legend to display map correctly). 

Fig.25. Change map 1990-2000 for Chicago, IL
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9. Working with change maps in QGIS

Using pan and zooming  icon choose area of interests. 

Pan a map

Zoom in/Zoom out

Fig.26. Change map 1990-2000 for the part of Chicago, IL

Navigate to area of interests
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9. Working with change maps in QGIS

Save map as image 
Map displayed in Map window in QGIS can be saved as image (PNG, JPG) using 
Projects – Save as image from main menu. 

Fig.27. Change map 1990-2000 for the part of Chicago, IL



10. Compose map using Print Composer tool 
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Print Composer provides layout to create nice maps that can be printed or saved as PDF-
file, an image (i.e PNG) or an SVG-file. It allows you to add elements such as the QGIS 
map canvas, text labels, images, legends, scale bars and more.

Before you start to work with the Print Composer, first raster or vector layers need to be 
loaded to QGIS and appropriate styl need to be set.  After everything is symbolized to 
your liking, choose Project – New Print Composer from main menu to launch Print 
Composer.

You will be prompted to choose a title for the new Composer.

More information about using Print Composer is in QGIS documentation. 
http://docs.qgis.org/2.18/en/docs/user_manual/print_composer/index.html

Please read for more details:
http://docs.qgis.org/2.18/en/docs/user_manual/print_composer/overview_composer.h
tml

Save map composition to file

Add map

Add title

Add legend

Add scalebar

Move map

Map view

Item properties

Fig.28. Print Composer in QGIS

http://docs.qgis.org/2.18/en/docs/user_manual/print_composer/index.html
http://docs.qgis.org/2.18/en/docs/user_manual/print_composer/overview_composer.html


10. Compose map using Print Composer tool 
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Fig.29. Type composer name

Example of using Print Composer will be presented based on percentage 
map of Hispanic (calculated in the 8. section of this tutorial)

• Load percentage map to QGIS
• Set appropriate colors for percentage map. 
• Choose Project – New Print Composer from main menu to launch Print Composer.
• You will be prompted to choose a title for the new Composer.
• Type perc_map as a title

Fig.30. Add layer to Print Composer

Add new map to Print Composer 
On the left side, select the toolbar button and draw a rectangle on the canvas 
holding down the left mouse button. Inside the drawn rectangle the QGIS map view to 
the canvas.



10. Compose map using Print Composer tool 
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Fig.31. Set scale for map added to Print Composer

Add scale bar

Select the         toolbar button and click with the left mouse button on the Print 
Composer canvas. A scale bar will be added to the canvas.

Add map title
Select the        toolbar button and click with the left mouse button on the Print 
Composer canvas. A title will be added to the canvas. 

Fig.32. Item properties: Scale bar and title

Map title in Print Composer

Clik on Font button to define Font



10. Compose map using Print Composer tool 
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Add legend
Select the         toolbar button and click with the left mouse button on the Print 
Composer canvas. A legend will be added to the canvas. Default are added legend for all 
layers which are loaded to QGIS

Fig.33. Legend properties dialog in Print Composer

Uncheck Auto update option in Item properties for Legend. 

Using          icon (in item properties window for Legend) remove 
il_cook_hispanic2010myc and il_cook_pop2010myc layer. 

Using icon (in item properties window for Legend) type new name for layer (This 
name will be displayed in Legend)

Fig.34. New layer name to be displayed in Legend 



10. Compose map using Print Composer tool 
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Fig.35. Map of percentage of Hispanic in 2010, Cook county, IL

Save map to file
Choose one of those icon                         and save map to file. 



11. Exploring demographic grids in QGIS
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Plugins

Plugins provide many new features and functions to QGIS. One of example is 
OpenLayers Plugin, which provides Google, Bing and Open Street map to be displayed in 
QGIS. 
Plugins are available in Manage and install plugins from Plugins menu. 

Fig.36. The         All menu (Plugins dialog)



Space Informatics Lab – University of Cincinnati

Install OpenLayers Plugin

Fig.37.  Installation of OpenLayers Plugin. 

• Select All in Plugin menu and 
choose OpenLayers Plugin 
from the available list. 

• OpenLayers Plugin will be 
highlighted, then click on 
Install Plugin button on the 
bottom right part of the dialog 
window. 

• OpenLayer Plugin will be 
installed.

Fig.38.  Installation of OpenLayers Plugin. 

11. Exploring demographic grids in QGIS

• Check OpenLayer Plugin to 
activate it. 
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Working with OpenLayers Plugin

Choose Web – OpenLayers plugin menu and select one of the available basemap. There 
are available Bing Maps, Google Maps, OpenStreetMap and more. You can choose 
between ”Street ” map, ”Satelitte image ” map or ”Hybrid”. 

Fig.39. OpenLayers Plugin menu. 

11. Exploring demographic grids in QGIS



• Using pan and zooming  icon choose area of interests. 
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Exploring racial diversity map in QGIS
• From main menu choose Layer – Add Layer – Add Raster Layer or choose the 

icon in the left panel of QGIS window. Select il_cook_div2010myc.tif 
from il_cook/diversity directory and open it. 

• Choose Web – OpenLayers plugin – Bing Maps – Bing Road. Bing Road will be 
added to QGIS. 

Fig.40. Bing road maps and racial diversity map in QGIS.

11. Exploring demographic grids in QGIS
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Exploring racial diversity map in QGIS
• Open Layer Properties window and go to Transparency (To open Layer Properties 

double click on the layer name in the map legend, or right click on the layer name 
and choose Properties from the context menu. 

• Set Global transparency for about 50%. 
• Click on OK. 

Transparency will be set for racial diversity map and the name of the streets will be seen.  

Fig.41. Transparency settings. 

Fig.42. Racial diversity for the part of the Chicago overlat into Bing Road Map. 

11. Exploring demographic grids in QGIS


